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Welcome

JtdU r-mn Thank you for downloading the UpdateAgent Online Edition, the easiest way to update all
the System software, Control Panels, Extensions, Applications, and Utilities on your
Macintosh computer. The Free Check-Up updates your Mac OS software. You can pur-
chase UpdateAgent so it updates all your software. See the Features for a quick overview.

buy online now

Using UpdateAgent

To update:

UpdateAgent Check-Up=——H

Waiting for Start button,

| All Drives s

1 Double-click UpdateAgent to launch it. The Main window opens.

2 Optionally, select ‘Preferences:General’ from the ‘Edit’ menu to customize
UpdateAgent’s download folder, automatic schedule, automatic expansion, and
sounds.

3 Select the hard drives to scan and press the ‘Start’ button to begin scanning the
hard drives.

4 The UpdateAgent Results window listing all the required updaters opens. You can
de-select any updaters you don’t want and then press the ‘Get’ button.

5 The Get Files window displays the status of retreiving the files. The updaters are
dowwnloaded to a folder named ‘New Insider Updates’ located in the root folder of
your start up disk.

6 Install the updaters.

It’s that easy. Two clicks. All the software updaters you need.

If we can be of any assistance, please see the first page for contact information or click the
Insider logo to go to our web site. Thank you.
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Why Update?

Developing today’s software is an extremely complicated process whose final phase is
testing the software to verify that it functions properly under all conditions.
Unfortunately, despite all this testing, real world users often uncover situations that
cause software to fail. The software may also not function with new System software
or new versions of software that it depends on.
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Once developers are aware of these problems, they typically create an updater to patch
the application. One of the main reasons to update your software is to fix bugs that
cause crashes and lock-ups. Developers may also enhance the software’s perfor-
mance.

After developers release an application, they usually add features that are either
requested by users or weren't included in the previous release. They may also enhance
the user interface to improve the usability of the product. The second main reason to
update your software is to take advantage of all the latest features.

In summary, updating your software ensures the most stability, best performance,
most usable interface, and most complete feature set.

Updates versus Upgrades

An update is an enhancement to a current major software release. An upgrade is a
major software release which usually changes the feature set and user interface sig-
nificantly. Most developers provide updates for free but charge for upgrades.

Why not update manually?

Although releasing updates is not new, developers have been unwilling to incur the
costs of shipping updater diskettes to all customers that have registered their soft-
ware. Instead, the proliferation of online services and the Internet has made it possi-
ble for software developers to make their updaters freely available to users. Although
it is possible for you to manually update your software, it is generally not practical.
Manual updating requires you to take the following steps:

1 Locate the developer’s web site

2 Navigate to the software updaters web page for your product

3 Compare the version number of the updater with the software on your com-
puter

4 Download the updater, if applicable
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Why Update?

You must repeat this process for each Application, Control Panel, Extension, Utility, and
System software program you have installed. In addition, software developers’ web servers
may refuse your connection or download sluggishly. Manually updating software is a very
time consuming and tedious task that users avoid; it therefore does not get performed
thoroughly or regularly.

The advantages of using
UpdateAgent

The combination of Insider’s extensive repository of updaters, Insider’s high performance
Internet servers, and the UpdateAgent program effectively and simply solve the updating
problems. The UpdateAgent staff is dedicated to scouring the Internet and online services
to locate updates. In addition, many software developers send their updaters to us as soon
as they are available. We are committed to maintaining the most comprehensive collection
of Macintosh software updaters.

To provide the best performance possible, we store all the updaters on our state-of-the-art
servers, which are connected to the Internet with industrial strength lines. We constantly
monitor performance to serve you better.

The UpdateAgent application automatically identifies your outdated software. It also pro-
vides the convenience of allowing you to schedule the updating process during non-work-
ing hours so that updating becomes essentially invisible. In addition, the software can
turn off your computer when your update session is complete.

The result is that you receive all applicable updaters as soon as they become available.
Once downloaded, you decide if and when you want to install the updater. UpdateAgent
does not automatically alter your installed software - you are in complete control.
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UpdateAgent contains many product features to deliver the easiest, most convenient
way to keep your software up to date.

» Fast

+ Secure

« Safe

+ Complete
+ Convenient

Fast and efficient

We scanned a 2GB hard drive with 1.7GB of data in 2 minutes and 2 seconds on a
stock Macintosh 8500/150. Before starting the test, we rebuilt the Desktop files and
ran Disk First Aid to repair any directory structure damage.

All updaters are downloaded from Insider Software’s high speed servers to avoid slow
sites and internet bottle-necks. All the updaters are stored as Stufflt archives. These
are typically 30% smaller than corresponding binhexed (.hqx) files for even faster
transmission.

The program supports native code for both PowerPC and 68k Macintoshes and uses
only 2MB of memory.

Complete security

There’s no other way to say this, so read slowly. Absolutely no information about your
software or hardware is ever transmitted anywhere.

100% safe

UpdateAgent does not install the updaters or change your software in any way. You are
in complete control of downloading and installing just what you want.

Most updaters on the planet

We are fanatic about making sure you receive every updater you deserve. Our custom
robot constantly monitors over 2000 developer sites in search of updates. Our web site
lets developers notify us as soon as updates become available. Our staff searches
many internet resources in search of new Macintosh software products and updates.
We boast the most comprehensive 1.3GB updater database available with over 2500
active updaters.
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~ ] Features & Benefits

JILALE . .

o ke r-mn The software delivers the correct updaters for your type of Macintosh. For example, you
only get updaters for 68k or PPC processors. In addition, you receive updaters that are tar-
geted specifically to your model, which is especially beneficial to PowerBook owners.

buy online now

If we are unable to deliver an updater, you receive a Read Me file instructing you on where
and how to get the updater. This may happen, for example, if a developer does not speci-
fy the version resource correctly.

You automatically receive a Read Me file for all your software that is eligible for a fee-
based upgrade. The file gives detailed instructions for upgrading your software.

You can even select to have Beta software delivered as soon as it’s released.

Time-saving features

You have the option to automatically decompress the files after they reach your comput-
er. You can also delete the archive automatically.

One of the most useful options is to automatically schedule your update sessions. Just
select the days and times and UpdateAgent delivers all the updaters and can even shut
down your Mac when it’s done.

The program keeps a convenient, sortable log of all your updaters. You can quickly view
New Updaters, Skipped Updaters, Downloaded Updaters, and Failed Downloads. Getting
one of these updaters again is as simple as checking it and pressing the Get button.
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Preferences

JUdU r-mn UpdateAgent provides two Preference windows. General Preferences is used to spec-
ify the folder to download updaters into, set a schedule to run UpdateAgent auto-
matically, and automatically expand the compressed updater files. The second win-
dow, Files Preferences, is used to specify particular software that you don’t want
updated and programs that you want Beta software for.

buy online now

To access the Preferences, select ‘Preferences’ from the ‘File’ menu. Then select
‘General for the General Preferences or ‘Files’ for the Files Preferences.

General Preferences

To access the General Preferences, select ‘Preferences’ from the ‘File’ menu and then
‘General’ from the sub-menu.

General Preferences

Copy new updates into:

| Select I Jupiter:Mew Insider Updaters;

_ [ Automatic Schedule
SiM|T T|F|s| |oz:00am 3]

[l Shut dowen swehen complete
] Sleep instead of shutting down

_ [+ Automatically expand updates

] Delete the archive after expanding

[' [l Activate Sounds [ Cancel ]



http://www.insidersoftware.com
https://insidertwo.theinside.com

Preferences

JUdU r-m To specify the folder for downloads
Press the Select button and select a folder. If this folder is moved or deleted,

UpdateAgent automatically creates a ‘New Insider Updates’ folder in the root folder of
your start up drive.
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To run UpdateAgent automatically

1. Click the ‘Automatically Update’ checkbox to activate the settings.

2. Click the Days of the Week to update. We recommend updating once per week with
the Online Edition. This is a handy feature for the CD Edition to update all the
computers after hours.

3. Click the hours and use the Up/Down arrows to set the start time. Click on the
minutes to set them as well.

4. Optionally, UpdateAgent can Shut down your Mac after it’s finished running. Click
the checkbox to enable this feature. If you prefer to put the computer to Sleep, and
your computer supports it, click the ‘Sleep’ checkbox as well.

To automatically expand the files

All the updaters are compressed, ‘stuffed’, as Aladdin Systems’ Stufflt archives. The files
must be decompressed, ‘unstuffed’, before they can be used. UpdateAgent contains the
ability to decompress the files without the need for any other programs.

1. Click the checkbox labeled Automatically expand updaters’ and UpdateAgent will
unstuff each file after it’s copied.

2. You can delete the stuffed file automatically by checking ‘Delete the archive after
expanding’

If you have any problems running UpdateAgent after selecting this option, increase the
amount of RAM allocated to the program by:

1. click once on the program icon to select it
2. select ‘Get Info’ from the Finder’s ‘File’ menu
3. increase the Preferred Size by 500k

Play Sounds
If you have installed the optional sounds, uncheck this box to not play them.
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Preferences

Lo Hlgent File Preferences

buy online now To access the File Preferences, select ‘Preferences’ from the ‘File’ menu and then ‘Files’
from the sub-menu.

Files Preferences

IUpdatESVEEta\ Drag and drop programs

Don't update these programs

[ Add I [Hemuve] -|

To exclude files from being updated
Make sure the ‘Updates’ tab is selected and Drag and Drop program files into the win-
dow or click the Add’ button and select the program.

To delete a file from the list, select it and press the Remove’ button.

Press the ‘Done’ button when you're finished to save the changes and close the window.
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Preferences

naaie
bl m To get Beta software

Developers may release ‘Beta’ software. These are programs that have usually gone
through internal testing but have not been tested by the public. Developers generally fix
any reported problems with the software and then release the final version.
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Make sure the ‘Beta’ tab is selected and see the previous section to add and remove pro-
grams.
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Results Window

All the Updater files are managed through the ‘UpdateAgent Results’ window. This
window opens automatically during an updating session and displays the required
updaters. You can also open it by selecting ‘Open Log’ from the File menu. The win-
dow is comprised of three sections: Updater display, controls, and Updater informa-

buy online now

tion.
LipdateAgent Results
Get Name 5ize  Date
- Updates E
apple CO-EOM S.4.5it a1k May 19, 1997
Colarsafe 1.5.2.50t 118k Aug 19, 1993
Control Panels Strip 3.2.50t 12K Jul 29, 1993
Dirmension 3.0.1 .sit S0ak Aug 11,1997
eflerge 1.5.1 .50t &35k Apr 3, 1995
Extensions Strip 1.58.1 sit 315K Aug S, 1993
FinderPop 1.7.3.sit 241k oct 19, 19938
Fant Gander Pro 1.5.sit 416k oot 16, 1995
FontDoctor 3.0r2 EMLSit 3K zz2,1995  [a
Funnel Web 2.0.1 EM.sit ok Aug e, 1995 (|
Imagetice 1.1.1 .5t 205K Sep 16, 1995 F
[ Delete from list I Viewfilesby: @@ staws  (Jkind | Cancel I -
= Details Hore Page Lpdater Page
® |mproved scanning across track boundaries of an audio disc using the AppleCD (=
fudio Player i
o [mproved sleep mode for CO-ROM drives ol
¢ [mproved handling of empty track lists ™
®wWithversion 5.3.3 of the CD-ROM driver there were prnhlems pla'_-.-'lng audm [ |
Ll Pt ol | i S i o al H L O T Y. B POH
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Results Window

iz HAgent Updater Display

buy online now The top section displays all the updater files. Each updater name follows the same

naming convention:
[Product Name|[new version][PPC or 68k][.sit]

for example, [FontAgent][3.0][PPC][.sit]. If the Updater is a ‘Read Me’ file, then RM’
is added to the name. The Updater Name is followed by the Updater’s size and the
date it was released.

Updater Categories
The Updater files are differentiated into three kinds:

1. Updates - regular program Updaters

2. Upgrades - detailed information about fee-based Upgrades

3. Beta - Beta software. This category is only included if you have selected to get
Beta software.

In addition, the Updaters are classified into four Status categories:

1. New - files identified in the current session

2. Skipped - files that were de-selected from downloading
3. Downloaded - files already downloaded

4. Failed - files that failed to download correctly

To change the order of the categories, click the ‘Status’ or ‘Kind’ radio buttons. For
example, to view all the new files, select ‘Status’. To view all the Upgrades, select
‘Kind’.

Each Kind and Status category has a disclosure triangle next to it to open and close
the list.

To select files to download
Make sure the checkbox next to the Updater name is checked.
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Results Window

SN r-m To change the sort order

The Updaters are initally sorted by their filename. Click on the other headings to sort by
the Updater’s size or the date it was released.
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To change the window's size
Drag the re-size box above the ‘Get” button. The window will re-size vertically.

To delete files from the display

To permanently remove a file from the display, click on the name to select it and press
‘Delete from List’. UpdateAgent will treat it as a Skipped Updater but suppress it from
the display.

To get more information about an updater

Select the Updater file by clicking on it’s name. Open the disclosure triangle labeled
‘Details’ at the bottom of the window to display additional information. To go to the
developer’s Home page, click the ‘Home Page’ hot-link. Similarly, the ‘Updater Page’ goes
to the developer’s page dedicated to this updater. This information is included when
available.

To download the files
Click the ‘Get’ button.
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Get Files Window

The ‘Get Files’ window shows the status of downloading the updater files. The highlight-
ed file is the one currently being downloaded. Once downloaded, it changes to grey and
a checkmark displays next to it.

Get Files

Get Description AiZe Date
u'" Adobe lllustrator 5.0 EM.sit kK Aug 25, 19935 E
p'" Apple CD-ROM 5.4 5it 21K Pay 19, 1997
H"" Colorzafe 1.5.2.51t 118K Aug 19, 1995
u'" DeBabelizer 3.0 EM.sit k. Feb 24, 199&
'./ Dirnension 30,7 .50t S0EK Aug 11, 1997
eierge 1.5.1.50t B35k Apr 9, 1995
FileMaker Pro 4.1 EM.sit G4 Sep 21, 1998
FinderPop 1.7.3.50t 241K Qct 19, 19938
Funnel Web 2.0.1 EM.sit 3k Aug e, 1995
HardDisk Toalkit 2.5 EM.sit Sk Jan 19, 1993
ImageNice 1.1.1.5it 205K Sep 16, 1998
lormegatWare Tools 1.0a.5it 2391k Sep 9, 1995
Lasso 2.5.1a Security Patch.sit 216K Sep 9, 1995
MW 93 Internet Assistant BR.sit 3K Jun 4, 1993 —
Dutlook Exp File Attach Fix.sit 3k Jul 30, 1995 %
Cutlook Express 4.0.2 50t 3161k Sep 24, 1995 =
G o - . . L {1

6of26files [l | | skip | | skipan |

kb zec Tirne rernaining: D run in background {sloswer )

Get Files Window

The status at the bottom of the window shows the count of files, the progress of the cur-
rent file, the current throughput, expressed as kilobytes per second, and the time
remaining for the current file.
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Get Files Window

Lo Hlgent To skip a file

Click to uncheck the checkbox before it starts downloading. If it has already started,
press the ‘Skip’ button. These files are all categorized as ‘Skipped’.

buy online now

To skip all files
Press the ‘Skip All’ button to cancel the download. This categorizes the current and all
remaining files as ‘Skipped’.

To run UpdateAgent in the background

To maximize the download speed, UpdateAgent uses a certain amount of your comput-
er’s power. If you want to run UpdateAgent in the background without noticably affect-
ing the foreground application, select the checkbox labeled ‘run in background’.
UpdateAgent will use less processing power but will download slower.
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Installing Updates

UpdateAgent does not automatically install the updaters for a variety of reasons.
Primarily, software updaters come in a variety of formats and usually requires user inter-
action. You should launch each updater and follow the on-screen instructions to install it

properly.

buy online now

This section describes different types of updaters and how to install them on your com-
puter. To comply with the developer’s copyright, Insider Software does not modify any
updaters. Also, Insider Software takes no responsibility for their non-performance and we
are unable to assist you with their installation. If you have any questions or problems you
should contact the developer directly. We recommend that you back up your current soft-
ware before applying the update.

To make it easier to identify an updater, Insider renames the stuffed file as:
[product name] [version after updating] [PPC or 68k] [.sit]

for example, Font Box 2.1 PPC.sit. Most updaters contain a detailed ‘Read Me’ file that
describes installation and the enhancements that the updater makes.

68k, PPC, or Both

All Macintosh computers prior to the Power Macintosh use Motorola processors (CPUs)
based on the 68000 (pronounced ‘sixty eight thousand’) design. These CISC (Complex
Instuction Set Computing) processors include the original 68000, the 68020, 68030, and
68040. Software written for the 68000 processor are identified as ‘68K’, where ‘K’ is a
shorthand notation for ‘thousand’.

The Power Macintosh computers use a RISC (Reduced Instruction Set Computing)
processor known as the PowerPC. This line currently includes the original 601, the low-
power 603 and 603e, the 604 and 604e, and 750 (G3). Software written to take advantage
of these processors is identified with ‘PPC’.

Developers also create FAT” software that runs at maximum speed on either a 68K or PPC
processor. The UpdateAgent software determines the kind of CPU you have and down-
loads the specific updaters for your machine.
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Installing Updates

'Jli”du!m“ Update Installers

buy online now These programs are designed to update a particular version of a particular software prod-
uct. After launching the program, the Installer either automatically locates the product or
asks you to select it. The ‘Read M’ files with these installers usually include instructions
for any other steps you may need to perform.

Replacement Programs

These programs consist of Applications, Control Panels, Extensions, and Utilities that
completely replace your installed version. To install the Control Panels or Extensions, drag
them over the closed System folder. If you don’t see a message to replace the existing file,
then you need to remove the old Control Panel or Extension manually. To install new
Applications, replace your old copy with the new one.

Disk Images

These files are images of floppy disks. To avoid creating a physical floppy disk, we recom-
mend using either ShrinkWrap™ or Apple’s Disk Copy 6.1.2 or later. Disk Image files usu-
ally appear of type ‘Document’ and are 1.4MB in size. Please refer to ShrinkWrap or Disk
Copy to use the disk images.
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Registering

The Free Check-Up updates your Macintosh System software only. To update all your
applications, Control Panels, Extensions, and Utilities obtain an Access Code and enter it
into the Free Check-Up. This activates UpdateAgent into the Edition you prefer:

CD Edition

The UpdateAgent CD Edition contains 1.3GB of the latest updaters and the UpdateAgent
CD Edition that updates your computers over your network. One set is $89.95 and four
issues delivered every three months is only $249.95.

Standard Edition
Updates all the software on one Macintosh for an entire year for only $49.95. You may
update as often as you'd like.

Limited Edition
Updates all the software on one Macintosh one time for only $12.95. Get this version if you
don't have a lot of software or your programs don’t change often.

The software will function on that computer only. If you change your computer, you must
contact us to modify your access code and registration information.

Obtaining an Access Code

The most convenient method is to select ‘buy online now’ (above left). This link takesyou
to our secure server where you provide credit card information and receive anAccess
Code immediately. Best of all, it’s open 24 hours a day.

If you choose one of the methods below, we need the following information to process
your order:

+ the product you are purchasing

+ your name and, optionally, your organization’s name

« if paying by credit card, include the credit card number and the card's expiration
date

+ how to contact you - any combination of phone number, fax number, e-mail
address, or postal address
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Registering

Unlocking UpdateAgent

After you receive an Access Code, select ‘Unlock’ from the File menu and type thecode in
exactly as it was given to you. The Access Code must be entered on the sameday you
receive it. If there is any problem, feel free to contact us.

Contacting Insider Software

By Phone
We're open between 8 am and 6 pm Pacific Time Monday through Friday.

+ US Sales: 800-700-6340
+ International Sales:+1- 760-804-9900 (GMT -8)
* Support: 760-804-9900

By e-mail

+ Sales: sales@insidersoftware.com
To protect the privacy of your credit information, we suggest that you send two e-mail
messages:

1 Specify the product and half the credit card number in the first message
2 Specify the rest of the credit card number and the card's expiration date in the sec-
ond message

We will e-mail back an access code as soon as we receive the messages.

+ Support: support@insidersoftware.com
+ Updater information: updates@insidersoftware.com
* Miscellaneous: agent@insidersoftware.com

By fax
+1-760-804-9995

Send a fax with your registration information. We'll get back to you within the next busi-
ness day.
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Registering

LA HAgent By mail

Insider Software Inc
6412 Merlin Drive, Suite 700
Carlsbad, CA 92009 USA

buy online now

Send a letter with your registration information and payment. We will send an access
code using the method you request.
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CD Edition

If youre responsible for more than a couple of Macs, or if all your Macs don’t have an
Internet connection, then the CD Edition is for you.

About the CD Edition

The 2 CD set contains over 1.2 GB of compressed updaters representing the newest
Macintosh updaters released. The CD Edition includes an unlimited license to update as
many Macs as you can.

The CD Edition includes a special UpdateAgent application designed to read the updaters
from the CDs over a local network. It uses standard Macintosh File Sharing to make the
CDs available on the network and conveniently update each workstation.

The CD Edition functions exactly like the Online Edition. The only difference is that it
reads the updater database and updater files over the network from the CD.

Updating between Releases

When you purchase the CD, you also receive the UpdateAgent Online Edition to update
your Macs between CD releases.

Prices
The CD Edition is available two ways:

1 Get one set of CDs for $89.95
2 Get four sets of CDs delivered every three months for only $249.95
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